Volunteer Scheduler Pro for Events
Quick Start Guide
Introduction
Welcome to Volunteer Scheduler Pro for Events! This quick start guide will help you quickly setup the
program to schedule the volunteers at your event in just a few easy steps. You'll be lead through the
process of creating your shifts, customizing and distributing your enrollment form, filling all your
shifts, and giving your volunteers online access to their schedules. We strongly recommend that you
print out this guide by choosing “Print…” from the File menu and read it through while you get started
with VSP for Events.

Step 1: Entering your jobs
The first thing you should do if you are new to Volunteer Scheduler Pro for Events is specify the jobs
you will be scheduling. A job is any task that is performed by your volunteers at any of your shifts. For
each shift, you will be able to specify how many volunteers in each job should be scheduled.
To create a job, first click on the Jobs heading on the left hand side of Volunteer Scheduler Pro’s main
screen (the screen which appears when you launch the program). Then click the “New Job…” button.
In the dialog that appears enter a name for the new job (e.g. “Traffic Director”, “Usher”, etc.).
There are several options available on the left hand side of the dialog that affect how positions in the
job appear and are scheduled. These options include separating the job into multiple “subdivisions”,
numbering positions in the job, scheduling the same volunteer for the job for a week at a time, and
more. These options are not discussed in this Quick Start Guide, but you may click on them inside VSP
to see a short explanation of what each option does.
For the purposes of getting started with VSP, just enter the name of
the job in the “Name” field, and then click OK. Then click the
“New...” button again to repeat this process for each of the other
jobs you will be scheduling.

Step 2: Creating the shifts for your event
After you've entered all your jobs, click on the Schedules pane on
the left hand side of VSP's main screen and enter the start and end
dates for your event. Clicking the calendar icons to the right of the
fields will produce calendars from which you can select the dates.
After you have entered your event's start and end date, click on the
“Generate Schedule Skeleton” button. A window will open that
contains a blank schedule spanning the date range you specified.
Now you'll want to create your shifts. Click on a day in the calendar
on which one of your shifts take place, and then click the “New
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Shift...” button at the top of the window.
In the dialog that appears, you can set the start and end time for the shift by clicking on the hours or
minutes and typing in the correct value or by using the little arrows next to each value to adjust it
incrementally.
If the shift repeats on other days of the week, use the controls under the “Repeats:” heading to setup the
appropriate repeating pattern. The other instances of this shift will automatically be created for you.
Next you should specify how many volunteers from each job are required for this shift. Select a job
from the list and type the number of required volunteers for that job. (You can also use the controls that
appear below the job list to adjust this number.)
Once you have configured this shift for the correct times, days, and required jobs, click OK. Then
repeat this process for all your other shifts. When you have finished creating all your shifts, choose
“Save” from the File menu at the top of the schedule window. A dialog will open asking you to enter a
name for the schedule and several other options. You can just leave all the options at their default value
and click OK to save the schedule.

Step 3: Testing and customizing online enrollment
You are now ready to walk though how your volunteers will enroll online for your event! Click on the
Web Terminal pane on the left hand side of VSP's main screen. At the top of the pane, you'll see your
“Enrollment URL”. This is the URL that your volunteers will visit to sign up for your event. You'll
email this URL to your volunteers and you can also post it as a link on your organization's website.
Click on your Enrollment URL now. Your web browser will open to your enrollment form. We'll see
how you can customize this form later. For now, fill it out as if you were a volunteer singing up to work
at your event for the first time. Enter your name and contact information, and choose the jobs that you
are interested in performing. For scheduling, you may choose between two options. If you choose the
option to be scheduled “Whenever my help is most needed”, an area will appear in which you can
specify any times at which you are not available. If you choose the option option “For specific dates,
times, and jobs,” you'll see the shifts you created in step (2) appear and you can select the ones you'd
like to work. When you are done, click the Submit button at the bottom of the enrollment form.
Now go back to VSP's main screen and click the “Web Forms” pane on the left hand side to see what
enrollment forms will look like when they are received by the VSP for Events administrator (you). As
soon as you click on this pane, the enrollment form you submitted will be automatically processed. (If
VSP is closed when an enrollment form is submitted, the form is automatically processed in real time.)
When your enrollment form is processed, the following will occur:
•
•

You will appear as an active volunteer in the Volunteers pane.
If you chose the option to be scheduled “Whenever my help is most needed” when filling out
the form, you'll see the unavailable dates dates you entered in your profile. As your event
approaches, you'll use the auto-scheduler to fill empty positions with volunteers who have
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•

•

chosen this option.
If instead you chose the option to be scheduled “For specific dates, times, and jobs,” you will be
placed in the shifts you selected, which you can verify by opening the scheduled from the
Schedules pane on the left hand side of VSP's main screen.
An email will be sent to you that confirms your enrollment form was received and processed,
and gives you the information you need to login to the Web Terminal, where you can check
your schedule, sign up for additional shifts, and request a sub if necessary.

When you receive your enrollment confirmation via email, use the link in the email to login to the Web
Terminal and see how volunteers can check their schedules, sign up for additional shifts, and request
subs if necessary.
Now that you've seen how the enrollment process works, let's take a look at how it can be customized
for your organization's specific needs. Go to the Web Terminal pane on the left hand side of VSP's main
screen, and then click the “Web Terminal Settings” button at the top of the Home tab. In the dialog that
appears, a variety of customization options are available. Among many other options, you can:
•
•
•
•
•

Customize the information requested during enrollment.
Enter descriptions for your jobs to be displayed on the enrollment form.
Customize the text of the enrollment confirmation email.
Brand your enrollment form and the Web Terminal with your organization's logo.
Turn on automatic email reminders so volunteers are reminded of their shifts automatically.

Take a look through these options to get a feel for the customization options that are available, and
choose the settings that best fit the needs of your organization.

Step 4: Distributing your Enrollment URL
Once you've customized your Enrollment form and the Web Terminal for your organization's needs,
you are ready to distribute your Enrollment URL so that your volunteers can sign up for your event.
There are three methods you can use to distribute your Enrollment URL:
(1) You can post the URL as a link or your organization's website. To do so, go the Web Terminal pane
on the left hand side of VSP's main screen and then click the “Copy...” button next to your Enrollment
URL. Then open an email your organization's web master, choose “Paste” from the “Edit” menu to
include the URL, and instruct him or her to post the link on your organization's web site.
(2) You can paste the URL into an email and then send it to a list of contacts using your own email
program. To send such an email, just copy the enrollment URL and paste it into an email that
introduces your event and invites the recipients to sign up online. See method (1) above for instructions
on copying the URL and pasting it into an email. (Note that it is considered best practice to “BCC”
emails to long lists of people, instead of including all addresses in the “To” field, in order to keep
individual email addresses private.)
(3) You can import a list of contacts into VSP from a spreadsheet or text file, and then send them an
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email containing the Enrollment URL using VSP's Emailer. The advantage to using this method over
method (2) is that any information you already have on file for the contacts (names, phones, emails,
mailing addresses) will be automatically by filled in for them when they open the enrollment form. To
use this method you'll choose “Import Volunteers” from the file menu at the top of VSP's main screen.
For help with the importation process, please refer to VSP's complete documentation. After importing
the volunteers, go to the Emailer heading on the left hand side of VSP's main screen, and replace the
default email with an email inviting the recipients to enroll. Insert your Enrollment URL in the email
by choosing “{{WebTerminalEnrollmentPageLink}}” from the “Web Terminal” submenu of the
“{{Token}}” menu. Send the email by clicking on the “Send...” button.

Step 4: Filling in empty shifts with the auto-scheduler
Once you've distributed your Enrollment URL, volunteers will start filling up shifts in your schedule by
submitting enrollment forms in which they request specific shifts. Other volunteers will enroll and offer
to help “whenever their help is most needed.”
As your event approaches, you'll want to fill the holes in the schedule with the later volunteers, i.e.
those who have offered to help when they are most needed. To do so, open your schedule by selecting it
in the Schedules pane on the left hand side of VSP's main screen and then click “Open”.
By clicking on an empty position in the schedule, you can see the volunteers that are able to fill that
position. By default, only volunteers who have indicated that they would like to serve “whenever their
help is most needed” and who are available at that time will be shown in the list. (You can show all
volunteers by clicking on the “Show only volunteers who...” button and unchecking the filters.)
To fill empty positions in the schedule automatically, click on the “Auto-schedule” button in the upper
right hand corner of the schedule window. You'll see that you are able to choose the shifts that the autoscheduler will fill, and also limit the maximum number of hours that any volunteer will be scheduled.
By limiting the maximum number of hours, you can ensure that you do not over-schedule volunteers,
even if there are few volunteers compared to the number of empty shifts. If you do not specify a
maximum number of hours, then the volunteers who have offered to work “whenever their help is most
needed” will be scheduled as many times as necessary to fill all the gaps in the schedule.
After running the auto-scheduler, you can see how many hours each volunteer has been scheduled by
choosing “View Hours Scheduled...” from the Reports menu. (If you are unhappy for any reason with
how the auto-scheduler filled in the schedule, you may always choose “Revert to saved...” from the File
menu to roll back the assignments made.)
After you have filled in empty positions in the schedule by auto-scheduling volunteers, you should send
an email to all volunteers letting them know that the schedule has been finalized. (Otherwise, the
volunteers would only see that they have been assigned if and when they logged into the Web
Terminal.) To send such an email, click on the Emailer pane on the left hand side of VSP's main screen.
You'll see an email that is ready to be sent to your volunteers that will provide them with the link to
your Web Terminal home page and their personal usernames and passwords that are automatically
generated for them by VSP. Tokens enclosed in {{curly brackets}} will be replaced with the
appropriate information for each volunteer when the email is sent. (You can click on the “Preview”
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button at the top of the pane to see how the email will look when sent to each volunteer.) When you are
ready to send the email, click on the Send button.

Conclusion
You should now have a good feel for how VSP for Events works to streamline scheduling and make
volunteering easier. The program also contains hundreds of other features that were not touched on in
this Quick Start Guide. Some of the highlights include, rosters, mailing labels, attendance tracking, and
teams. For an inventory and explanation all of VSP for Events's features please refer to the complete
documentation. Also, please do not hesitate to contact us as questions arise. We are happy to help you
make sure that all your organization's specific scheduling needs are met.
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